JSF Tools Reference Guide
Version: 3.3.0.M5

1. Introduction ................................................................................................................. 1
1.1. Key Features of JSF Tools .................................................................................. 1
2.

3.

4.
5.

1.2. Other relevant resources on the topic .................................................................. 2
JavaServer Faces Support .......................................................................................... 3
2.1. Facelets Support ................................................................................................ 4
2.1.1. Creating a JSF project with Facelets ......................................................... 4
2.1.2. Facelets components ............................................................................... 6
2.1.3. Code assist for Facelets ........................................................................... 6
2.1.4. Open On feature ...................................................................................... 8
Projects ...................................................................................................................... 11
3.1. Creating a New JSF Project .............................................................................. 11
3.2. Importing Existing JSF Projects with Any Structure ............................................. 17
3.3. Adding JSF Capability to Any Existing Project .................................................... 17
3.4. Adding Your Own Project Templates .................................................................. 19
3.5. Relevant Resources Links ................................................................................. 21
Web.xml Editor .......................................................................................................... 23
JSF Configuration File Editor .................................................................................... 25
5.1.
5.2.
5.3.
5.4.

Diagram view ....................................................................................................
Tree View .........................................................................................................
Source View .....................................................................................................
Editor Features .................................................................................................
5.4.1. Open On ...............................................................................................
5.4.2. Code Assist ...........................................................................................
5.4.3. Error Reporting ......................................................................................
6. Managed Beans .........................................................................................................
6.1. Code Generation for Managed Beans ................................................................
6.2. Add Existing Java Beans to a JSF Configuration File ..........................................
7. Creation and Registration ..........................................................................................
7.1. Create and Register a Custom Converter ...........................................................
7.2. Create and Register a Custom Validator ............................................................
7.3. Create and Register Referenced Beans .............................................................
8. JSF Project Verification .............................................................................................

25
30
48
50
50
50
52
55
55
64
67
67
74
82
91

iii

iv

Chapter 1.

Introduction
JSF Tools are especially designed to support JSF and JSF-related technologies. JSF Tools
provide extensible tools for building JSF-based applications as well as adding JSF capabilities
to existing web projects, importing JSF projects and choosing any JSF implementation while
developing JSF application.
This guide provides the information on JSF tooling you need to allow you to quickly develop JSF
applications with far fewer errors.

1.1. Key Features of JSF Tools
The table below lists the functionality provided by the JSF Tools.

Table 1.1. Key Functionality for JSF Tools
Feature

Benefit

Chapter

JSF and Facelets
support

Step-by-step wizards for creating new JSF and Chapter
Facelets projects with a number of predefined JavaServer

2,
Faces

templates, importing existing ones and adding Support
JSF capabilities to non-JSF web projects.
Flexible and
customizable

Jump-start development with the supplied Chapter 3, Projects
templates or easily create customized

project template
management

templates for re-use.

Support for JSF
Configuration File

Work on a file using three modes: diagram, Chapter
5,
tree and source. Automatic synchronization Configuration

JSF
File

between the modes and full control over the Editor
code. Easily move around the diagram using
the Diagram Navigator.
Support for Managed
Beans

Adding new managed beans, generating code Chapter 6, Managed
for attributes, properties and getter/setter Beans
methods.

Support for Custom
Converters and

Fast creation of custom converters and Chapter 7, Creation
validators with a tree view of the faces- and Registration

Validators

config.xml file.

Verification and
Validation

All errors will be immediately reported by Chapter
8,
JSF
verification feature, no matter in what view Project Verification
you are working. Constant validation and error
checking allows you to catch many of the errors
during development process that significantly
reduces development time.
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1.2. Other relevant resources on the topic
All JBoss Developer Studio and JBoss Tools release documentation can be found
on the RedHat Documentation [http://docs.redhat.com/docs/en-US/JBoss_Developer_Studio/
index.html] website.
Nightly documentation builds are available at http://download.jboss.org/jbosstools/nightly-docs
[http://download.jboss.org/jbosstools/nightly-docs/].
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JavaServer Faces Support
JSF Tools does not lock you into any one JavaServer Faces implementation. You can always
specify the desired JavaServer Faces implementation while creating a new JSF project (see
Section 3.1, “Creating a New JSF Project”), adding JSF capability to any existing Eclipse project
(see Section 3.3, “Adding JSF Capability to Any Existing Project”), or importing existing JSF
projects (see Section 3.2, “Importing Existing JSF Projects with Any Structure”).
At this point the special wizard will prompt you to specify an appropriate JSF environment. It may
be JSF 1.1.02 RI, JSF 1.2, JSF 2.0 or JSF 2.1. The wizard also lets you select JSF implementation
with a component orientation such as JSF 1.2 with Facelets or MyFaces 1.1.4.

Figure 2.1. Choosing JSF Environment
After specifying an appropriate JSF environment, all the required libraries associated with the
selected version will be added to your project.
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2.1. Facelets Support
In this section we will focus all the concepts that relate to working with Facelets.
Facelets extend JavaServer Faces by providing a lightweight framework that radically simplifies
the design of JSF presentation pages. Facelets can be used in a variety of ways that we will
consider further in this section.

2.1.1. Creating a JSF project with Facelets
If you want to build an application using Facelets, create a project with Facelets based on version
1.2 of the JSF Reference Implementation, i. e. select the JSF 1.2 with Facelets option in the JSF
Environment section of the New JSF Project wizard.

Figure 2.2. Choosing Facelets Environment
Once you have selected the environment, it is possible to specify one of three available templates:
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Creating a JSF project with Facelets

Figure 2.3. Choosing Facelets Template
The following table lists the templates that can be used with Facelets for any JSF project, and
gives a detailed description for each one.

Table 2.1. Facelets Templates
Template
FaceletsBlankWithoutLibs

Description
Some servers already provide JSF libs and you risk
library conflicts while deploying your project. To avoid
such conflicts, use a template without libs if you have a
server with its own JSF libraries.

FaceletsKickStartWithRILibs

A sample application with Facelets that is ready to run.

FaceletsKickStartWithoutLibs

A sample application without libraries.
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2.1.2. Facelets components
The JBoss Tools Palette comes with the Facelets components ready to use. A useful tip appears
when you hover the mouse cursor over the tag; this tip includes a detailed description of the tag
component, the syntax and available attributes.

Figure 2.4. Facelets Components

2.1.3. Code assist for Facelets
JSF Tools provides Facelets code assistance, which can be accessed by pressing Ctrl+Space.
It is available for Facelets tags while editing .xhtml files.

6

Code assist for Facelets

Figure 2.5. XHTML File Code Assist
Code assist is also available for jsfc attributes in any HTML tag.

Figure 2.6. Code Assist for JSFC Attribute
After selecting an jsfc attribute, the code assist feature will list the JSF components available
on a page.
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Figure 2.7. Code Assist for JSF Components
When a component is selected you will see all available attributes for it.

Figure 2.8. Available Attributes for the Component

2.1.4. Open On feature
Finally, JSF Tools supports Eclipse's OpenOn™ feature while editing Facelets files. Using this
feature, you can easily navigate between the Facelets templates and other parts of your projects.
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Open On feature

By holding down the Ctrl key while hovering the mouse cursor over a reference to a template, the
reference becomes a hyperlink to navigate to that template.

Figure 2.9. Template Hyperlink
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Projects
To take an advantage of JSF you will need to perform one of the next steps:

• Create new JSF projects
• Import (open) existing JSF projects
• Add JSF capability to any existing Eclipse project
• Import and add JSF capability to any existing project created outside Eclipse.
This section will go into more detail for each step.

3.1. Creating a New JSF Project
It is easy to create a new project that contains all the JSF libraries, tag libraries and JSF
configuration file with the aid of a special wizard. To get it, select File → New → Other → JBoos
Tools Web → JSF → JSF Project and click the Next button.
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Figure 3.1. Choosing a JSF Project
On the next page you will be prompted to enter the Project Name and select a location for the
project (or just leave a default path).
The JSF Version option also allows you to specify the JSF implementation to use.

12

Creating a New JSF Project

Figure 3.2. Creating a New JSF Project
There are a number of predefined project templates that are both flexible and easily customizable.
You can pick a different template on which the projects Importing Existing should be based on.
Almost all templates come in two variations: with and without JSF libraries.
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Figure 3.3. Choosing JSF Templates
The table below provides description for each possible JSF template.

Table 3.1. JSF Project Templates
Template

Description

JSFBlankWithoutLibs

This template will create a standard Web project structure with all the
JSF capabilities.
Use a template without libs to avoid library conflicts when your server
already has JSF libraries installed.

JSFKickStartWithoutLibsThis template will create a standard Web project structure, and also
include a sample application that is ready to run.
Use a template without libs to avoid library conflicts when your server
already has JSF libraries installed.
On the next page you need to select which Servlet version to use, and specify whether or not to
register this application with JBoss AS (or other server) in order to run and test your application.
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Creating a New JSF Project

The Context Path option defines the name under which the application will be deployed.
The Runtime value tells Eclipse where to find the Web libraries necessary to build (compile) the
project. It is not possible to finish the project creation without selecting a Runtime. If you do not
have any values, click the New... button to add new Runtime.
The Target Server option allows you specifying whether or not to deploy the application. The
Target Server corresponds to the Runtime value selected above. If you do not want to deploy the
application, uncheck this option.

Figure 3.4. Registering the Project on Server
When you are all done, you should see that the project has appeared in the Package Explorer
view:
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Figure 3.5. A New Project in the Package Explorer
At this point you can open the faces-config.xml file and start working on your application. There
are a lot of features available when developing JSF applications. These features will be discussed
in more detail later in this document.
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3.2. Importing Existing JSF Projects with Any Structure
For detailed information on migration of JSF projects into a workspace see the Migration Guide.

3.3. Adding JSF Capability to Any Existing Project
It is also possible to add JSF™ capabilities (JSF libraries, tag libraries) to any existing project in
your workspace. After that you will be able to make use of features such as the JSF configuration
editor, JBoss Tools JSP editor and any others. No pre-existing web.xml file is necessary.
Right-click on the project in the Project Explorer, bringing up the context menu. From this menu
navigate to Configure → Add JSF Capabilities.

Figure 3.6. Add JSF Capabilities menu item
This will open the Project Facets dialog for the project. Click the checkbox next to JavaServer
Faces. You undertake further configuration by clicking the Further configuration available
button at the bottom of the dialog; this will allow you to define specific configuration options. Click
Apply and then the OK on the Project Facets dialog when you are finished.
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Figure 3.7. Project Facets dialog
The project will now contain a new node (visible through the Project Explorer) named Web
Resources.You will also notice new files within the WebContent folder.
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Note:
Some application servers provide their own JSF implementation libraries. To avoid
conflicts you should not add JSF libraries while adding JSF capabilities.

You can now open the new faces-config.xml file, that is found under your projects WebContent
→ WEB-INF folder. This file can be opened in a unique editor (see Chapter 5, JSF Configuration
File Editor).

3.4. Adding Your Own Project Templates
A template is a set of files that is provided as a basis when creating a new project. Project templates
provide content and structure for a project.
JSF Tools provides powerful template capabilities which allow you to create new templates and
import existing JSF projects. This templating facility has a variety of aspects to consider. Let's
start with the most straightforward case and consider the process of creating a template from your
existing JSF project.
Let's say you have a project that you want to use as the basis for a new template. The following
steps will show you how to achieve this:

• In the Web Projects view, right-click the project and select JBoss Tools JS → Save As
Template

Figure 3.8. Saving Your Project as Template
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• In the first dialog box, you can specify a name for the template (it will default to the project name)
and confirm what run-time implementation of the project technology will be used.

Figure 3.9. Define Template Properties

• When you click the Next button a dialog box will be presented with your project structure
displayed, along with a number of check boxes. Here you can select only those parts and files
in your project directory that should be part of the template.
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Relevant Resources Links

Figure 3.10. Define Template Properties
• At this point, unless you want to designate some extra files as having Velocity template coding
inside them, you should click the Finish button.
That's it. This template can be used with any new or imported project that uses the same run-time
implementation as the project you turned into a template.
At this point you have a fully configured project. Now you can add some additional logic to it
starting with the JSF configuration file.

3.5. Relevant Resources Links
You can find a more in-depth explanation on how to work with the special wizards, editors and
views that can be used while developing JSF applications in our Visual Web Tools Guide.
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Web.xml Editor
The web.xml file inside the WEB-INF folder is a deployment descriptor file for a Web Application.
It describes the servlets and other components and deployment properties that make up your
application.
JBoss Tools add the web.xml file to created JSF project automatically and provides a special
editor for its editing. See the Visual Web Tools guide for more information on the web.xml editor.
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JSF Configuration File Editor
First, we should mention that JSF configuration file (faces-config.xml) is intended for registering
JSF application resources such as Converters, Validators, Managed Beans and page-to-page
navigation rules.
Now, let's look at how you can easily configure this file by means of a special graphical editor for
the JSF configuration file. The editor has three main views:

• Diagram
• Tree
• Source
They can be selected via the tabs at the bottom of the editor.

5.1. Diagram view
Here, we will show you how to work with JSF configuration file through the Diagram view of the
editor.
As you can see on the figure below, the Diagram view displays the navigation rules container in
the faces-config.xml file:
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Figure 5.1. Diagram View
If you have a large diagram, make use of the Outline view. Within it you can switch to a Diagram
Navigator mode by selecting the middle icon at the top of the view window. This allows you to
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Diagram view

easily move around the diagram. Just move the blue area in any direction, and the diagram on
the left will also move:

Figure 5.2. Outline View for Diagram
To create a new page here, you should click the page icon (View Template) on the toolbar from
the left and then click anywhere on the diagram. A New Page Wizard will appear.
To create a transition for connecting pages:

• Select the transition icon from the toolbar (New Connection).
• Click the source page.
• Click the target page.
A transition will appear between the two pages:
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Figure 5.3. Transition between JSP Pages
It is also possible to create a new page with context menu by right-clicking anywhere on the
diagram and selecting the New View... option.
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Figure 5.4. Creating a New View
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To edit an existing transition, first select the transition line. Then, place the mouse cursor over the
last black dot (on the target page). The mouse cursor will change to a big +. At this point, drag
the line to a new target page:

Figure 5.5. Editing Transition between Views

5.2. Tree View
You can find it more convenient to edit your JSF Configuration file in the Tree view of the VPE.
The view displays all JSF application artifacts referenced in the configuration file in a tree format.
By selecting any node on the left, you can view and edit its properties which will appear in the
right-hand area. Let's look at the structure of this tree more closely.
• Under the Application node you can adjust JSF application specific settings such as
internationalization, extensions, adding property and variable resolvers, etc.
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Tree View

Figure 5.6. JSF Application Specific Settings
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• The Components node is for registering custom JSF components. Right-click and select New
→ Component or just click the Add button in the right-hand area to add a new component to
the JSF Configuration file.
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Tree View

Figure 5.7. Registering a New JSF Component
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In the Add Component wizard you should set a component type and point to a component class
by using the Browse button or create a new class for this component by using the ComponentClass link.

Figure 5.8. Adding a New JSF Component to the JSF Configuration File

• Use the Render Kit node to create and register a set of related renderers for custom JSF
components.
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Figure 5.9. Adding a New JSF Renderer Kit to the JSF Configuration File
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• Under the Converters node you can create a converter class for your JSF application either
with an id or for a proper class. For more information on this procedure see Section 7.1, “Create
and Register a Custom Converter”.
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Tree View

Figure 5.10. Creating a New Custom Converter
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• The Managed Bean node allows you to create and register Bean classes in your JSF
application. Read more on the topic in Chapter 6, Managed Beans.
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Tree View

Figure 5.11. Managed Beans
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• Use the Navigation Rules node to configure a navigation between the pages in your
application. Here you can create a new navigation rule and adjust necessary properties for it
in the right-hand area.

Tip:
The same you can do in the Diagram view of the JSF Configuration file editor (see
Section 5.1, “Diagram view”).
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Tree View

Figure 5.12. Configuring Navigation Rules
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• Under the Referenced Beans node you can add a new Referenced Bean and configure various
properties for it. To learn more on this refer to Section 7.3, “Create and Register Referenced
Beans”.
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Tree View

Figure 5.13. Referenced Beans
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• The Validators node is needed to create validator classes for organizing the validation of your
application data. You can read more on the topic in Section 7.2, “Create and Register a Custom
Validator”.
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Tree View

Figure 5.14. Validators
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• The Extensions node is for setting extensions in your faces-config.xml file.
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Tree View

Figure 5.15. Adding Extensions
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In the Tree view you can also edit the properties of the selected element with the help of the
Properties view as shown below:

Figure 5.16. Properties View

5.3. Source View
Here, we'll discuss how you can configure your faces-config.xml file with the help of the Source
View.
The Source View for the editor displays the text content of the JSF configuration file. It is always
synchronized with other two views, so any changes made in one of the views will immediately
appear in the other:
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Source View

Figure 5.17. Source View
You can also work in the Source View with the help of the Outline View. The Outline view shows
a tree structure of the JSF configuration file. Simply select any element in the Outline View, and
it will jump to the same place in the Source editor, so you can navigate through the source code
with Outline View.
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Figure 5.18. Outline View

5.4. Editor Features
Here we'll discuss a very important features that JSF configuration file editor provides when
working with JSF resources.

5.4.1. Open On
The JSF configuration file editor comes with the very useful OpenOn navigation feature. You can
find more information on this feature in the Visual Web Tools Reference Guide.

5.4.2. Code Assist
Code Assist provides a pop-up tip to help you complete your code statements. It allows you to
write your code faster and with more accuracy.
Code assist is always available in the Source mode:
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Code Assist

Figure 5.19. Code Assist in Source View
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5.4.3. Error Reporting
Constant error checking is provided while you are developing your project. This greatly reduces
your development time as it allows you to catch many errors during the development process.
Errors will be reported by Chapter 8, JSF Project Verification facility:

Figure 5.20. Error Reporting in Source View
Other errors are also reported.
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Figure 5.21. Other Errors Reporting
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Managed Beans
JSF Tools provides a number of useful features when working with managed beans, such as:

• Adding and generating code for new managed beans
• Generating code for attributes and getter/setter methods
• Adding existing managed beans to a JSF configuration file
This guide will look at each of these features in more detail.

6.1. Code Generation for Managed Beans
To begin, create a new managed bean in JSF configuration file editor using the Tree view.
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Figure 6.1. Creation of New Managed Bean
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Note:
When you define a new managed bean, make sure that Generate Source Code
option is checked as shown in the figure below.

Figure 6.2. New Managed Bean
After the Java class has been generated you can open it for additional editing. There are two ways
to open a Java class:

• Click on the Managed-Bean-Class link in the editor.

• Right click the managed bean and select the Open Declaration option.
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Figure 6.3. Opening of Created Managed Bean

58

Code Generation for Managed Beans

The generated Java source should look as follows:
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Figure 6.4. Java Source Code
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Code Generation for Managed Beans

You can also generate source code for properties, also includes getter and setter methods. Right
click on the bean and select New → Property. You will then see the Add Property dialog.
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Figure 6.5. Generation of Source Code for Properties
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When the form is open make sure that all the check boxes are selected:

• Add Java property
• Generate Getter
• Generate Setter

Figure 6.6. "Add Property" Form
Once the generation is complete, you can open the file and see the newly added property with
accompanying "get" and "set" methods:
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Figure 6.7. Generated Java Source Code for Property
This covers the options available when creating a new Managed Bean. The next section will show
you how to add an existing Bean into a JSF configuration file.

6.2. Add Existing Java Beans to a JSF Configuration
File
If you already have a Java bean you can easily add it to a JSF configuration file.
You should start the same way you create a new managed bean. Use the Browse... button to
add your existing Java class.
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Figure 6.8. New Managed Bean Form
Once the class is set, its Name will be set as well. But you can easily substitute it for the other
one. Notice that Generate Source Code option is not available as the Java class already exists.
After adding your class the Next button will be activated. When you click it you will be presented
with the Managed Properties dialog where all corresponding properties are displayed. Checking
the appropriate ones will add them into your JSF Configuration File.
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Figure 6.9. Selection of Bean's Properties.
If you don't want to add any, just click the Finish button.
The steps above have demonstrated how you can add an existing Bean to the JSF configuration
file, i.e. faces-config.xml. The next chapter will demonstrate how to organize and register other
kinds of artifacts.
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Creation and Registration
7.1. Create and Register a Custom Converter
It's also possible to create a custom Converter in order to specify your own converting rules. Let's
look at how you can do this.
To create and register a custom converter it is necessary perform the following steps:

• In the Project Explorer view open the faces-config.xml file and select Tree tab.
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Figure 7.1. Converters

• Select Converters and click the Add button.
• On the form type the name of your converter in the Converter-id field and name of the class for
converters. After clicking Finish button your custom converter is registered under the entered
name.
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Create and Register a Custom Converter

Figure 7.2. Add Converter Form

• Now you can create a "converter" class. In the Converter section you should see your
Converter-id and Converter-class. Click on the Converter-Class link to generate the source
code.
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Figure 7.3. Generation of Source Code for Converter Class
• A usual wizard for creating a Java class will appear. All needed fields here will be adjusted
automatically. Just leave everything without changes and click the Finish button.
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Figure 7.4. New Java Class Form
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• To open a converter class click again on the Converter-Class link in the Converter section.
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Create and Register a Custom Converter

Figure 7.5. Converter Class
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Now you are able to add a business logic of converter in the Java editor.

7.2. Create and Register a Custom Validator
It is also quite easy to develop your own custom Validators. The required steps are similar to
those shown previously:

• In the Project Explorer view open the faces-config.xml and select the Tree tab.
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Figure 7.6. Validator in Faces Config Editor
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• Select the Validators option and click the Add button.
• Type the name of your validator in the Validator-id field and name of the class for validators.
After clicking the Finish button your custom validator is registered under the entered name.

Figure 7.7. Adding Validator
Now you can create the "validator" class.

• In the Validator section you can see your Validator-id and Validator-class. To generate the
source code click on Validator-class.
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Create and Register a Custom Validator

Figure 7.8. Creating Validator Class
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• Java class will be created automatically. Leave everything without changes and click the Finish.
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Create and Register a Custom Validator

Figure 7.9. New Java Class Form
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• To open the validator class click on the Validator-Class link in the Validator section. Now you
are able to write a business logic of validator in the Java editor.
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Create and Register a Custom Validator

Figure 7.10. Converter Class Editing
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7.3. Create and Register Referenced Beans
The creation of Referenced Beans is similar to the creation of Custom Validators. The steps below
show you the steps required to create Referenced Beans.

• In the Project Explorer view open the faces-config.xml and select the Tree tab.
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Figure 7.11. Referenced Beans in Faces Config Editor
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• Select the Referenced Beans option and click on the Add button.
• Type in the name of your Referenced Bean and type in or select the Referenced-Bean-Class
value by clicking the Browse button.

Figure 7.12. Add Referenced Bean

• In the Referenced Bean section you should see your Referenced-Bean-Name and
Referenced-Bean-Class. Click on the link to open the Java creation wizard.
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Create and Register Referenced Beans

Figure 7.13. Create Referenced Bean Class
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• The Java class will be created automatically. Leave everything with their default values and
click the Finish button.
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Create and Register Referenced Beans

Figure 7.14. New Java Class Form
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• To open a Referenced Bean class click the Referenced-Bean-Class in the Referenced Bean
section. Now you are able to write business logic of Referenced Bean in the Java editor.
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Create and Register Referenced Beans

Figure 7.15. Referenced Bean Class Editing

89

90

Chapter 8.

JSF Project Verification
In this chapter we'll discuss a possible verification that you can take advantage of.
Many different rules are checked for a JSF project that can be configured by selecting Window
→ Preferences from the menu bar, selecting JBoss Tools → Web → JSF → Validation.
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Figure 8.1. JSF Rules
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Suppose you are working in the Source viewer for a JSF configuration file as shown below:

Figure 8.2. Faces-config.xml File
While typing a class name, you might make a minor typo (like "demo.Person9" instead of
"demo.Person" ). After saving the file, verification checks to make sure everything is correct and
finds the error below:
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Figure 8.3. Error in Source View
Notice that the Package Explorer View shows a marked folder and a marked file where the error is.
You can place the cursor over the line with an error message and get a detailed error message:
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Figure 8.4. Error Message
Verification also checks navigation rules:
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Figure 8.5. Checking Navigation Rules
If you provide a page name that does not exist, verification will let you know about that:
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Figure 8.6. Page Name Verification
In summary, this document highlights all the JSF-specific features of JBoss Tools meant for
enhancing the development of rich Web applications based on JSF technology. The reference
introduces you to wizards for creating and importing JSF projects, JSF Configuration File editor
features, functionality for enabling JSF capabilities and etc.
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